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Introduction: Welcome to EndNote

Introducing EndNote
Welcome to EndNote—the complete reference solution! 

EndNote is an online search tool—it provides a simple way 
to search online bibliographic databases and retrieve the 
references directly into EndNote. (EndNote can also import 
data files saved from a variety of online services and library 
databases.)

EndNote is a reference and image database—it specializes in 
storing, managing, and searching for bibliographic 
references in your private reference library. You can 
organize images—including charts, tables, figures, and 
equations—and assign each image its own caption and 
keywords. 

EndNote is a bibliography and manuscript maker—it 
formats citations, figures, and tables in Microsoft® Word 
with the Cite While You Write™ feature. Watch the reference, 
figure, and table lists grow as you insert citations in your 
manuscript. Microsoft Word templates guide you through 
the exacting manuscript requirements of publishers. 

You can also create bibliographies using Format Paper with 
other word processors.

See “What’s New in EndNote X2” on page 9 for a list of the most 
recent features added to EndNote.

For late-breaking news and updates, please go to: 
http://www.endnote.com/support.

About The Demo Version of EndNote and 
the EndNote Viewer

If you are working with the demonstration version of EndNote 
X2, you have 30 days after you first use the program to evaluate 
EndNote and all of its features. After those 30 days, the Demo 
version will revert to a feature-restricted EndNote Viewer.

NOTE: While you can see the entire list of Microsoft Word templates 
available with the full version of EndNote, the demo version includes 
only the Nature manuscript template specifications. Any of the 
manuscript templates you choose will launch the Nature manuscript 
template.
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After the program reverts to an EndNote Viewer, you still will be 
able to open EndNote libraries, search, sort, and print references. 

With the EndNote Viewer you will not be able to:

Add or edit references in a library that has 10 or more 
references already in it. 

Format more than 10 citations in a paper. 

Retrieve more than 10 references from a remote database. 

Import more than 10 references. 

Export more than 10 references at one time. 

To purchase an unrestricted version of the EndNote program, 
please contact Thomson ResearchSoft.

About This Getting Started Guide
This guide provides a basic overview of installing and using 
EndNote. It is not a complete user’s guide, but rather is intended 
as a guided tour to show you the highlights of the EndNote 
program.

This guide assumes that you know how to use your Windows 
operating system and your word processor. For help on these 
topics, consult your computer owner’s guide or your word 
processor manual. 

Often there is more than one way to select a command in 
EndNote. A single command may be available from one of the 
main menus, from a context-sensitive right-click menu, from a 
toolbar icon, or with a keyboard command. In most cases, this 
manual gives instructions for selecting commands from the main 
menus. If a menu command has a keyboard equivalent, the 
keyboard command appears next to the menu item.

The following representations for key combinations are used:

Instruction Explanation

CTRL+ESC While holding down the CTRL key, press 
the ESC key. 

CTRL+ALT+ENTER While holding down the CTRL and ALT 
keys, press the ENTER key.

Menu names, menu selections, and button names appear in italic 
text. 
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Customer Services

Register Your 
Copy of 
EndNote

If you haven’t done so already, please fax or email 
your registration to Thomson ResearchSoft (go to 
http://www.endnote.com/encontact.asp). You also have the 
opportunity to register during installation. Even if you 
purchased EndNote directly from Thomson ResearchSoft, do not 
assume that you are registered. Registered users receive:

free technical support

special upgrade offers

notification of new EndNote versions that are compatible 
with the latest version of your word processor

The EndNote 
Manual and 
Online Help

The EndNote Manual:  The complete EndNote manual is 
available as a PDF file, and is installed in your EndNote folder.

Online Help:  The online Help file is another source of 
information about EndNote. From EndNote’s Help menu, select 
Contents to view the various topics. For context-sensitive help, 
click the Help or ? button found on various windows and dialogs, 
or press the F1 key on your keyboard.

Release Notes:  For documentation updates and correction notes 
for this release, refer to the Readme.txt file installed in the 
EndNote folder.

Late Breaking News: For late-breaking news and updates, 
please go to: http://www.endnote.com/support.

Customer 
Service

Contact Sales for general product information, pricing, quantity 
discounts, and referrals to dealers. 

Contact Customer Service to order new copies or upgrades of 
EndNote, to check billing/shipping status, and to register your 
software.

Sales Information
Phone: 760 438 5526 (country code is 01)
Fax: 760 438 5573 (country code is 01) 
Web/Email: http://www.endnote.com/encontact.asp
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Customer Support (Orders, Billing, and Shipping)
Phone: 800 336 4474 (country code is 01)
Fax: 215 386 2911 (country code is 01) 
Web/Email: http://www.endnote.com/encontact.asp

Technical 
Support

Contact Technical Support if you encounter problems while 
using EndNote. When you contact us, please have a clear 
description of the problem and know the version of your copy of 
the Windows system, EndNote, and your word processor. (To 
find the EndNote version, start EndNote and choose About 
EndNote from the Help menu.) Also have your EndNote serial 
number available.

Web/Email/Phone: http://www.endnote.com/encontact.asp

For hours and holiday closures, please see: 
http://scientific.thomson.com/support/techsupport/hours/

Technical support tips are also available from the EndNote 
website and the EndNote Discussion Forum (see the sections that 
follow in this manual).

International 
Customer and 
Technical 
Support

For customer support or technical support outside of North 
America, please visit our website to check for a local distributor. 

Go to http://www.endnote.com, click on Contact Us, and then 
click on International Distributors to find a local distributor. 

The EndNote 
Website

The EndNote website (http://www.endnote.com) contains 
technical support tips, utilities for data transfer, and information 
about the latest versions of EndNote. You can learn about the 
various training options. You can also find updated styles, 
filters, connection files, and other related documents at this site. 
Go to the website and look under Support and Services.

To easily locate incremental updates available on the website, go 
to the Help menu in EndNote and select EndNote Program 
Updates.
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The EndNote 
Discussion 
Forum

If you wish to join an ongoing forum of EndNote users like 
yourself, go to the EndNote website at 
http://www.endnote.com, click on Support and Services, and 
then scroll down and click on the link to go to the EndNote 
Discussion Forum. You can browse several EndNote message 
lists, easily search for topics, and join to add messages.

ADA VPAT Thomson ResearchSoft is dedicated to developing software 
products that are usable for everyone, including those with 
physical challenges and disabilities. EndNote was designed to 
adhere to the ADA (Americans with Disabilities Act) Section 508 
accessibility standards.

Please visit our website at http://www.endnote.com, and click 
the Support & Services link to access the VPAT (Voluntary 
Product Accessibility Template) document that describes the 
accessibility features that address the Section 508 Standards. The 
VPAT is an informational tool developed by industry and 
government to help facilitate the understanding of compatibility 
issues under Section 508.

What’s New in EndNote X2
EndNote X2 includes these new and enhanced features:

Start a search with the Search tab on the Tabs pane of the 
Library window. See “The Search Tab” in Chapter 8 of the 
full EndNote manual.

Quickly initiate an online search by selecting from your list 
of favorite connection files in the Groups pane. See “How to 
Search on Online Database” in Chapter 6 of the full EndNote 
manual.

Use Smart Groups to view and manage subsets of references 
in your library. Set up a custom search strategy to 
automatically add references to a Smart Group. See “Smart 
Groups” in Chapter 9 of the full EndNote manual.

Use several new reference types: Aggregated Database, Blog, 
Catalog, Pamphlet (such as a drug circular), Serial (for 
serialized books in a collection), and Standard. See 
“Reference Types and Fields” in Appendix C of the full 
EndNote manual.

Look for the full text of a referenced work, and attach the file 
(typically a PDF file) to your EndNote reference. See 
“Finding Full Text for a Reference” in Chapter 6 of the full 
EndNote manual.
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References now include automatic date stamp information. 
Each reference includes an Added to Library date and a 
Record Last Updated date in the footer of the reference. See 
“Date and Auto Date Stamp” in Chapter 5 of the full 
EndNote manual.

For references entered with EndNote version X1 or earlier, 
the “Added to Library” field is left blank and the “Record 
Last Updated” field displays the date of conversion to 
EndNote X2. For new installations, the former “Last 
Modified Date” field has been renamed “Custom 8” (existing 
reference type settings are retained).

Compress your library and automatically attach it to an 
email. See “Saving a Compressed Copy of a Library” in 
Chapter 4 of the full EndNote manual.

View a Library Summary that recaps library statistics. See 
“Library Summary” in Chapter 4 of the full EndNote 
manual.

View a Record Summary that recaps statistics for a particular 
reference. See“Record Summary” in Chapter 5 of the full 
EndNote manual.
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Chapter 1: Windows EndNote Installation

Before You Install EndNote 
Please read this section before you proceed with the installation. 

If you are installing the full version of EndNote (not the Demo 
version), you will need a valid EndNote product key to install 
the program. If you are upgrading from a previous version, you 
will also need your previous EndNote serial number.

Program 
Requirements

Both the full EndNote program and the EndNote Demo are 
available on CD or by downloading. If you have a CD you need 
a CD-ROM drive to install the program.

System Requirements: 

EndNote runs under the following operating systems: 

Windows XP, with Service Pack 2

Windows Vista 

Hardware Requirements:

A personal computer with a Pentium (or compatible) 450-
MHz or faster processor

A minimum of 256 MB of available RAM

A hard drive with at least 180 MB of free space

In order to use EndNote’s Online Search feature for 
searching online databases, an Internet connection is 
required. To use the Open Link command to access a website, 
you also need a Web browser installed.

NOTE: Make sure that your computer meets the system and hardware 
requirements before continuing. If necessary, contact the distributor, 
dealer, or store where you purchased EndNote to arrange for a full 
refund. If you have any problem obtaining a refund, contact Thomson 
ResearchSoft directly. You must do so within 30 days of purchase. 

Word 
Processor 
Compatibility

As of June 2008, EndNote for Windows is compatible with: 

Microsoft Word for Windows 2003 or 2007

RTF files created with most word processors, including: 
Microsoft Word, WordPerfect, OpenOffice, StarOffice, and 
WordPad.
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Open Document Format (ODT) documents created with the 
OpenOffice Suite.

Microsoft Word:

EndNote installs Cite While You Write commands in Microsoft 
Word. Word 2003 displays an EndNote submenu of commands 
on Word’s Tools menu. Word 2007 displays Cite While You Write 
commands on an EndNote tab. Cite While You Write allows 
EndNote to format citations and create a bibliography for the 
document that is open in Word. You can format, unformat, and 
reformat a document—without exiting your word processor.

In order for Cite While You Write to install properly, Microsoft 
Word 2003 or 2007 must be correctly installed on your computer 
prior to installing EndNote.

If a supported version of Microsoft Word is installed on your 
computer, the appropriate Cite While You Write files are 
installed automatically for the current user when you run the 
EndNote installation. This feature can be used with a shared 
copy of Word or on a network. 

RTF and ODT Documents:

For word processors other than Word, first write your paper and 
insert in-text citations. If the file format is anything other than an 
ODT document, save as an RTF file. Then, use EndNote’s Format 
Paper feature to format the citations and bibliography from your 
ODT or RTF file. See Chapter 12 in the full manual for details.

EndNote for 
Handheld 
Devices

If your computer has software installed to allow synchronizing 
with a Palm OS® handheld device or a Windows Mobile® device 
such as a Pocket PC®, the EndNote installation program will 
attempt to install EndNote for your handheld device. 

Requirements for running EndNote for the Palm Operating 
System include:

Handheld device 

Palm Operating System 4.x or later

Serial or USB communication for HotSync operations

16 MB RAM, with at least 8 MB available

NOTE: EndNote for Palm is not compatible with Palm desktop software 
version 6.2 or later, and will not install when Palm 6.2 or later is 
detected. We do not recommend configuring EndNote for Palm on 
Windows Vista due to Vista and Palm incompatibilities.
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Requirements for running EndNote on a Windows Mobile 
device include:

Windows Mobile handheld device, such as a Pocket PC 
(not including Smartphones)

Windows Mobile operating system 5 or later 

Serial or USB communication for ActiveSync operations

16 MB RAM

For information about how to install and use EndNote on a 
handheld device, see the EndNote Help file. In EndNote, go to 
the Help menu and choose Contents. See the Help topics in the 
“Palm OS Handhelds” book or the “Windows Mobile Device 
(Pocket PC)” book.

EndNote Installation
Follow these instructions to install the EndNote program. 

If you are upgrading from a previous version of EndNote, please 
see “Upgrading from an Earlier EndNote Version” on page 19.

Please see Chapter 23, “Networks and Volume Installations” in 
the full EndNote.PDF manual for information about using 
EndNote in a network environment, licensing, and performing 
mass installations.

Installing 
EndNote

To install EndNote:

1. Log in to the local machine with administrative rights or as a 
user with program installation privileges. Make sure no 
applications are running, including virus protection 
software. 

2. Start the EndNote installation program.

If you downloaded the EndNote installer: Double click the 
installer file to start the EndNote Setup program. 

If you received EndNote on a CD: Insert the CD into your 
CD-ROM drive. 

The EndNote Setup program will start. If you do not have 
Autoplay enabled, choose Run from the Start menu, type 
“d:\setup” (use the drive letter appropriate to the drive 
containing the installation CD) and press ENTER.
Chapter 1: Windows EndNote Installation 13



3. Follow the instructions on screen to complete the 
installation. Use the Next button to move forward between 
the installation dialogs.

Welcome: Thank you for selecting EndNote!

Registration Information: If you are installing the full 
version of EndNote, enter your EndNote product key. You 
must enter a valid product key to continue with installation 
of the full version of EndNote. The product key can be found 
in the EndNote X2 CD packaging, or on the order 
confirmation of your digital product. 

If you are installing the Demo version, choose the 
appropriate button. You do not need a product key or serial 
number to install the Demo version of EndNote.

User Information: Enter your name and organization.

If you are upgrading from a previous version, you must also 
enter your previous EndNote serial number. 

Read Me Information: Read late-breaking news about this 
version of EndNote.

Palm and Windows Mobile Read Me Information: Read 
late-breaking news about EndNote for the Palm OS and 
Windows Mobile OS.

End User License Agreement: You must select “I accept the 
license agreement” in order to continue with the installation.

Select Installation Type: We recommend that you select 
Complete to make sure you install all options, although you 
can choose Custom to hand pick the file groups to install.

Select Destination: By default, EndNote is installed in the 
C:\Program Files\EndNote X2 folder. The Demo version is 
installed in the C:\Program Files\EndNote X2 Demo folder. You 
can use the Browse button to change the folder selection if 
you wish. 

If a previous installation of EndNote is found in the same 
folder, you will be given the option to either back up or 
overwrite the older files. If you back up files, they are placed 
in a Backup folder in the installation folder.

NOTE: If the installer detects a full version (not a demo version) of 
EndNote on your computer, it will give you the option to continue with 
the installation or quit. If you continue, be advised that you will need to 
reinstall your non-demo version of EndNote to use it after you run the 
EndNote X2 Demo version.
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Select Components: (Custom installations only) If you 
selected a Custom installation, see “Selecting Features” on 
page 18.

Select Default Citation Manager: (Microsoft Word 2007 
only) If the installer detects Microsoft Word 2007, it asks 
whether to “Use EndNote as my default citation manager.” 
Cite While You Write will be installed in Word 2007 in any 
case, but when this item is selected the installer will hide 
Word’s native Citations and Bibliography commands (the 
group normally found on the References tab in Word) in 
order to avoid confusion for the user. 

Ready to Install: You can still click Cancel to stop the 
installation. Once you click Next, the installation program 
will begin installing EndNote files.

4. On the final “EndNote X2 is Successfully Installed” dialog, 
click Register to register your copy of EndNote, click Finish to 
close the installation program, or click Run to start EndNote.

To make sure the program installed correctly, see “Checking 
Your Installation” on page 21.

Installed Files The full EndNote installation includes the following default 
folders and files.

Program Folder
C:\Program Files\EndNote X2

EndNote X2.exe application file

EndNote.chm help file
You can double-click the file to view it. In the EndNote 
program, select EndNote X2 Help from the Help menu. 
Pressing the F1 key on your keyboard or clicking a Help or ? 
button in the program brings up a context-sensitive topic.

Readme.txt text file contains late-breaking news

EndNote.pdf is the full electronic manual

GettingStartedGuide.pdf gives a tour of the program

Examples shortcut folder
This is a shortcut to an Examples folder that contains sample 
files to follow the guided tour found in Chapter 3 and the 
Getting Started Guide, and to experiment with while 
learning EndNote.

Styles folder
This folder contains the full collection of over 3,000 
bibliographic styles.
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Connections folder
This folder contains thousands of connection files to connect 
to and search online bibliographic databases.

Filters folder
This folder contains hundreds of import filters for importing 
text files downloaded from online bibliographic databases.

Terms Lists folder 
This folder contains journal abbreviation term lists. These 
lists contain thousands of journal names and standard 
abbreviations. Import a list into your library’s Journals term 
list to use the abbreviations in your bibliographies.

Spell folder 
This folder contains spell check dictionaries for the EndNote 
spell checker.

Templates folder 
This folder contains Microsoft Word templates to quickly set 
up your papers for electronic submission to publishers.

Palm and Pocket PC folders
These folders contain Read Me files and support files that 
allow you to keep an EndNote library on a Palm handheld 
device or a Windows Mobile device. 

Various additional folders and files are installed to support 
the EndNote program and to integrate EndNote with other 
software programs.

Shared Folder
Open the Shared Documents or Public Documents folder in 
Windows Explorer to find the EndNote folder located at:

Windows XP:  Documents and Settings\All Users\Shared 
Documents\EndNote

Windows Vista:  C:\Users\Public\Public Documents\EndNote

Examples folder
This folder contains a sample library and other sample 
documents and graphics to use while learning EndNote.

You may want to use the shared EndNote folder to store your 
libraries, so that they are available to all users on your 
computer.
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Personal Folder
Open the My Documents or Documents folder in Windows 
Explorer to find the EndNote folder located at:

Windows XP:  C:\Documents and Settings\[UserName]\My 
Documents\EndNote

Windows Vista:  C:\Users\[UserName]\Documents\EndNote

These folders are created when you create or modify a file:

Styles folder contains new or modified bibliographic styles

Connections folder contains new or modified connection files

Filters folder contains new or modified import filters

While the program folder contains all of the default styles, 
connection files, and filters, your personal EndNote folder 
contains those files that you have created or modified. This 
prevents changes to the original files, and assures that you will 
not inadvertently delete a customized file when you remove or 
upgrade the EndNote program. It also allows you to make 
changes to files even though you may not have administrator 
access to modify files in the Program Files folder. EndNote 
displays a single list of the files found in both locations. If a file 
of the same name appears in both locations, EndNote will 
display only the file found in your personal folder.

You can change your personal folder locations; see “Folder 
Locations” in Chapter 19 of the full EndNote.PDF manual.

Preferences Folder
Depending on your settings, these folders may be hidden from 
view in Windows Explorer. 

Windows XP:  C:\Documents and Settings\[UserName]\
Application Data\EndNote

Windows Vista:  C:\Users\[UserName]\App Data\Roaming\EndNote

While many EndNote preferences are stored in the Windows 
registry, some are stored in your personal preferences folder. It 
contains the connect.log file that records your latest online 
search, the RefTypeTable.xml file that stores your reference type 
preferences, saved search strategies, and various other settings.
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Custom 
Installations

Although we recommend that you use the Complete installation 
option to install EndNote, the Custom installation option can be 
useful if you are low on disk space or if you need to reinstall only 
certain EndNote components. 

To do a new custom installation:

1. Follow the instructions for “EndNote Installation” on page 
13. 

2. On the dialog titled “Select Installation Type,” select Custom. 

3. When you get to the dialog titled “Select Features,” read the 
section below, “Selecting Features” to determine what you 
would like to select/deselect for installation.

NOTE: If the installer detects another copy of EndNote in the 
destination folder, it gives you options to either backup or remove older 
files during the installation. When doing a custom install, only selected 
components are affected. For example, if you are installing only the 
Anthropology styles, and you choose to remove older files, only the 
older Anthropology styles are removed; no other part of the installation 
is affected.

To install components after EndNote X2 is already installed:

1. Start the installation program as you would for a new 
installation.

2. On the “Application Maintenance” dialog, select the Modify 
option and click Next.

3. When you get to the “Select Features” dialog, read the 
section below, “Selecting Features” to determine what you 
would like to select/deselect for installation.

Selecting 
Features

There are several major categories of components that can be 
installed with EndNote.

The components you can select for installation include:

EndNote Application

EndNote Program
Sample Files

EndNote Help
PDF Manual
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Word Templates/Add-ins: 
Templates for Microsoft Word

Cite While You Write for Microsoft Word
Styles: These formats for creating bibliographies are 
grouped by type.

Connections: These files for directly retrieving references 
from online reference databases are grouped by information 
service provider.

Filters: These files for importing text files of reference data 
are grouped by information service provider.

Spelling Dictionaries: These are dictionaries available for 
the spelling checker.

EndNote for Palm OS and Windows Mobile: These are files 
required for using EndNote for the Palm operating system or 
the Windows Mobile operating system. 

To select or deselect an item for installation:

Click the plus sign next to each category to display a detailed list 
of items. For each category or subcategory, click the triangle next 
to the name to select from the available installation options. The 
options may include:

Will be installed on local hard drive.
Entire feature will be installed on local hard drive.
Will be installed to run from network.
Entire feature will be installed to run from network.
Feature will be installed when required.
Entire feature will be unavailable. 

Upgrading from an Earlier EndNote Version
Before you begin, back up any custom styles, import filters, and 
connection files that you do not want overwritten.

While it is not required, we recommend that you uninstall any 
earlier version of EndNote before you install EndNote X2. See 
“Uninstalling EndNote” on page 23.

NOTE: During installation, you will need to enter both your new 
EndNote X2 product key, which is found in the EndNote X2 CD 
packaging or on the order confirmation for your digital product, and your 
old EndNote serial number. (The Demo version of EndNote does not 
require these.)
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Install the upgrade just as you would a new installation. See 
“EndNote Installation” on page 13. By default, EndNote X2 is 
installed into the C:\Program Files\EndNote X2 folder.

Backing Up or 
Replacing 
Files

If Setup detects an earlier copy of the EndNote program in the 
installation folder, it alerts you and gives you two options. If you 
continue with the installation to install EndNote X2 into your 
existing EndNote folder, Setup removes the older EndNote 
application and word processor support files. You need to select 
what it should do with the styles, filters, and connection files 
from your older copy of EndNote. No matter which option you 
choose, your libraries will not be deleted; nor will any non-
EndNote files in the EndNote folder.

Backup older files: EndNote X2 provides complete, updated 
sets of style, filter, and connection files. But if you want to 
keep any of your older modified files to use with EndNote 
X2, you should choose this option. Doing so has EndNote 
create a “Backup” folder in the EndNote folder and all of the 
styles, filters, and connection files from your older 
installation are copied into that folder. After installing 
EndNote, you should move any of these files that you want 
to use into the Styles, Filters, or Connections folders installed 
with EndNote X2.

Remove older files: If this option is selected, Setup replaces 
all of the styles, filters, and connection files from your 
existing EndNote installation with the new ones included 
with EndNote X2. Do not choose this option if you have 
custom styles, filters, or connection files that you want to 
save. If they have the same names as any of the files to be 
installed, the installer will overwrite them with the new files.

Opening and 
Converting 
Old EndNote 
Libraries 

EndNote X2 opens and uses libraries created with EndNote 8 
and later. It converts libraries created with even earlier versions 
of EndNote to the latest file format. 

To convert an old EndNote library (created before version 8):

1. Start EndNote.

2. From the File menu, select Open and then Open Library. 

3. On the file dialog, locate and highlight the old library, and 
click Open.

EndNote will warn that the selected library was created with 
an older version, and will ask for permission to convert it. 
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4. Click OK to convert the library. Name the new library and 
click Save. The conversion makes a copy of the original library 
in the latest file format, and leaves the original library intact.

NOTE: Once you have opened and used a library with EndNote X2, you 
should use the library only with version X or later.

Using Old 
Style, Filter, 
and 
Connection 
Files

EndNote X2 can use custom styles, filters, and connection files 
that were created with EndNote versions 4.0.1-X2. Once you edit 
and save one of these files with EndNote X2, it is converted to the 
latest format, which can be used with EndNote versions 8 to X2.

All of the styles, filters, and connection files supplied with 
EndNote X2 have been updated to the latest format. The new 
filter and connection files can be used by previous versions of 
EndNote, with new fields simply ignored. However, the updated 
styles cannot be used with versions of EndNote prior to version 8. 

Checking Your Installation
To run EndNote, click the Start button, choose All Programs, 
select EndNote, and then choose EndNote Program.

 A dialog may ask you to open a library file. Choose Cancel or 
Close. To check the version number of EndNote, choose About 
EndNote from the Help menu. Click the splash screen to clear it. 

If you have trouble accessing the program, repeat the installation 
steps to verify that the program was correctly installed.
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Checking 
Microsoft 
Word Support

To see whether Cite While You Write is correctly installed, start 
Word. 

In Word 2003, click on the Tools menu and you should see 
EndNote commands on an EndNote X2 submenu. 

In Word 2007, you should see an EndNote tab.

Cite While You Write commands may not be available if you 
installed Word or upgraded your version of Word after installing 
EndNote. 

If Cite While You Write commands do not appear in Word, 
repair the EndNote installation:

1. Log in to the machine with administrative rights or as a user 
with program installation privileges.

2. From the Windows Start menu, select Control Panel, or 
choose Settings and then Control Panel.

3. Choose Add or Remove Programs.

4. Highlight EndNote X2 and click Change. 

5. Select Repair and click Next. 

Your entire EndNote installation is checked and repaired as 
needed.
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Automatically Updating Files
You can automatically update EndNote X2 when incremental 
program enhancements are available. 

To update your copy of the EndNote program:

1. Open a connection to the Internet. 

2. From EndNote’s Help menu, select EndNote Program Updates. 

The wizard checks for an update, lets you know whether an 
update is available, and then downloads the file(s) and applies 
the update to your EndNote installation.

NOTE: You can download the latest content files at any time from our 
website at http://www.endnote.com. We continually update output 
styles, filters, connection files, and Microsoft Word templates. 

Uninstalling EndNote
Before you remove EndNote, back up your libraries and any 
other files you have created or customized. 

For volume and site license installations, see Chapter 23, 
“Networks and Volume Installations” in the full manual.

Uninstalling 
Palm OS 
Support and 
Word 2007 
Settings

Palm OS files and Word 2007 settings are typically registered 
during installation of the EndNote program, and in those cases 
they will also be uninstalled along with the program. You can 
jump to the next section, “Uninstalling the EndNote Program.”

If you used the Configure EndNote utility for a specific user 
account, to register Palm OS files and/or suppress the “Citations 
and Bibliography” group on the References tab in Word 2007, 
you should use that utility again to uninstall. 

To uninstall Palm OS support and Word 2007 settings:

1. Log on to the workstation as the current user. You do not 
have to be an administrator.

2. Launch the Configure EndNote utility. You can do this in 
one of these ways:

From the Windows Start menu, choose All 
Programs>EndNote>Configure EndNote.

Go to the EndNote program folder and double-click 
"Configure EndNote.exe."

3. Select Remove all EndNote components for me and click Next. 
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4. Continue through the uninstall process as instructed.

This uninstalls only Palm OS support and a single Word 2007 
setting, and only for the current user.

Uninstalling 
the EndNote 
Program

To uninstall EndNote:

1. Log in to the machine with administrative rights or as a user 
with program installation privileges.

2. From the Windows Start menu, select Control Panel, or 
choose Settings and then Control Panel.

3. Select Add or Remove Programs.

4. In the list of currently installed programs, select EndNote X2.

5. Click the Remove button.

Or, you can uninstall by using the EndNote installation 
program:

1. Log in to the machine with administrative rights or as a user 
with program installation privileges.

2. From your EndNote CD, run Setup.exe.

3. On the “Application Maintenance” dialog, select Remove and 
click Next.

4. Click Next again to begin removing EndNote.

The uninstall procedure removes only files, groups, and icons 
installed by the EndNote installer the last time it was run. For 
example, if you used the Custom installation option to reinstall 
only style files, the Uninstall program removes only style files. 

To remove any modified EndNote files that remain:

We purposely do not to remove any EndNote libraries or 
customized files. You can manually delete these files with 
Windows Explorer. Once you are sure you do not want any of the 
files contained in the following folders, you can delete them:

Windows XP

C:\Program Files\EndNote X2
C:\Documents and Settings\All Users\Shared Documents\EndNote
C:\Documents and Settings\[UserName]\My Documents\EndNote
C:\Documents and Settings\[UserName]\Application Data\EndNote

Windows Vista

C:\Program Files\EndNote X2
C:\Users\Public\Public Documents\EndNote
C:\Users\[UserName]\Documents\EndNote
C:\Users\[UserName]\App Data\Roaming\EndNote
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Chapter 2: Introduction to an EndNote Library
This chapter covers the basics of working with EndNote. In 
particular, you will learn how to:

Start EndNote and open a library.

Sort the reference list.

Select, open, and close a reference in the EndNote library.

Save references to custom groups.

Quit from the EndNote program.

Start EndNote To start the EndNote program and open the sample library:

1. From the Start menu, choose Programs, select EndNote, and 
then choose the EndNote Program. If this is the first time you 
have used the program, a dialog appears prompting you to 
open a reference library.

NOTE: If you have set a favorite library to open automatically, that 
library will open instead of the dialog shown above. If this happens, 
close the library, choose Open from the File menu, and continue with 
step 3.

2. Select Open an existing EndNote library. 
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3. To open the library, do one of these:

Select Sample_Library.enl in the drop-down list, and click 
OK.

If Sample_Library.enl does not appear in the drop-down 
list, click Browse to locate it. A file dialog will appear, 
prompting you to locate and open a reference library.

Use the “Look in:” list to find the EndNote X2 folder. By 
default, this will be on the C drive in the Program Files folder. 
To get there, click the “Look in:” list, choose the “C:” drive 
and click Open; select Program Files and click Open; and then 
select and open the EndNote X2 folder.

Select the Examples shortcut that points to the Examples 
folder, and click Open. You should now see the file 
“Sample_Library.enl,” the example EndNote library. (Your 
folder View settings may or may not be set up to show the 
extension .ENL.) Select Sample_Library.enl and click Open.

NOTE: You can open a library from within EndNote by choosing Open 
from the File menu. 
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The Library 
Window

When you open the sample library you see the Library window 
listing all of the references that the library contains:

The Library window includes three panes:

The Reference List pane displays a multi-column list of 
references. By default, the first column in the reference list shows 
a paper clip icon for references that include an attached file in the 
File Attachments field. Then, the first author’s last name, the 
year, the title, the journal name or secondary title, the reference 
type, the URL, and the Last Updated date are displayed for each 
reference. 

The Groups pane at the left of the window lists various groups 
of references for easy retrieval.

The Tab pane displays a Preview tab to view formatted 
references and a Search tab for searching either the current 
library or an online database.

The information displayed in the reference list, as well as the font 
used for the display, can be changed using the EndNote 
Preferences.

Move column dividers to adjust column widths
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You can browse through your reference library by first selecting 
a reference, and then using the scroll bar, the scroll arrows, or the 
PAGE DOWN, PAGE UP, HOME, END, and ARROW keys. 

Preview 
References

You can easily see more detail about a reference by highlighting 
the reference and viewing the Preview tab at the bottom of the 
Library window.

To preview a reference:

1. First, if you do not have a Tab pane in the window, click on 
the Show Tab Pane button at the bottom of the window and 
then click on the Preview tab. 

2. For this example, click on the reference titled “Geophysical 
Research Letters.”

The Preview tab uses the current output style to display the 
selected reference as it will be formatted for a bibliography. 
EndNote’s output styles (or just styles) represent the rules 
for creating bibliographies for a variety of journals and other 
publications. The styles determine how your references look 
when you print, export, preview, or create bibliographies.

3. To select a different output style to apply to the reference, go 
to the toolbar and select Numbered from the drop-down list of 
output styles.

Only one reference is displayed on the Preview tab at a time. If 
multiple references are selected, only the active reference 
(surrounded by a dotted line) is displayed. The format of the 
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reference on the Preview tab can be changed at any time by 
choosing a different output style.

When the Tab pane is showing, a Hide Tab Pane button is 
available at the bottom of the window. You can click Hide Tab 
Pane to hide the Preview tab if you wish. The name of the button 
will toggle to Show Tab Pane.

Sort the 
References

References can be easily sorted by clicking on the column 
heading (such as Author, Year, or Title). 
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To change the sort order:

1. Click the Author column heading to change the current 
Author sort from ascending order to descending order.

NOTE: This example shows references that include Japanese 
characters. EndNote uses Unicode to encode special characters, so 
that data is easily translated between platforms, programs, and 
languages. If boxes appear instead of characters, you may need to 
change the EndNote display fonts to a Unicode font. You will learn how 
to do this in the next chapter, “Setting EndNote Preferences.” For some 
display elements, you may need to install special Windows Language 
Packs. Consult your Windows documentation for more information 
about Language Packs.

2. Click the Year column heading to see the references sorted in 
ascending order based on the year of publication.

3. Click the Year column heading again (a second time) to 
reverse the sort order and see the references sorted in 
descending order.

4. Now, click the Author column heading to return the sort 
order of the library to an alphabetical list sorted by the 
author names.
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Select and 
Open a 
Reference

To work with specific references you must first select them in the 
Library window.

There are different ways to select a reference, such as clicking on 
the reference using the mouse, using the arrow keys, or typing 
the first few letters found in the field by which the library has 
been sorted.

To see how this works, click once on any reference to select it. If 
you have arrow keys on your keyboard, press the UP or DOWN 
ARROW to select the previous or next reference. When the library 
is sorted by author name (as it should be now), you can also 
select a reference by typing the first few letters of the author’s 
last name. 

To quickly find and display a reference:

1. Select the first Argus reference in the list by clicking in the 
list and then typing “arg” without pausing between letters.

Now that the reference is selected, there are a number of 
things you can do with it, such as view its contents, copy, cut, 
delete, or edit it. For now, just open the reference to view the 
contents.

2. Open the selected Argus reference by pressing the ENTER key 
or by using the Edit References command on the References 
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menu. You can also open a reference by double-clicking on it 
in the reference list.

The Reference window opens to display all of the information 
associated with the reference.

This is where you enter or edit information for a reference. The 
citation information is displayed at the top of the Reference 
window in the title bar, “Argus, 1993 #32.” This information—
the first author’s last name, year, and record number—is used by 
EndNote to match citations in a paper to references in a library.

To view the rest of the reference, use the mouse to scroll down 
the Reference window, or press the TAB key to move forward 
from one field to the next. Press SHIFT+TAB to move backwards 
through the fields. Click the Show Empty Fields/Hide Empty Fields 
button to toggle between showing all fields in the reference and 
only those fields that contain data.

The window may also be resized by clicking and dragging the 
lower right window corner. To reposition the window, click on 
the title bar and drag the window to the desired location. 

Close the 
Reference

Next, close the reference. You can do this in one of these ways:

Click the close button in the upper corner of the Reference 
window. 

From the File menu, choose Close Reference. 

title bar
close 
button

Show or Hide empty 
fields in the reference.

Click and drag to resize the window.
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From the keyboard, press CTRL+W. Note that many of the 
menu commands have a keyboard equivalent next to them.

EndNote automatically saves all changes to a reference when the 
Reference window is closed.

Save 
References to a 
Custom Group

The left pane of the library window lists groups of saved 
references. In a new library, only the All References group 
contains references, and displays all of the references in the 
library. However, you can add up to 500 custom and smart 
groups to a library.

A custom group is built by specifically adding individual 
references to the group. A smart group is compiled 
automatically, and is based on a search strategy.

The sample library has several custom groups of references. 
Click on the group names under Custom Groups in the left pane 
of the library window to view the references in each group. Then, 
click All References to display all of the references in the library 
again.

To create a custom group and add references to it:

1. From the Groups menu, select Create Group. (Or, you could 
right click under Custom Groups in the Groups pane to 
display a context-sensitive menu, and then select Create 
Group.)

In the Groups pane of the Library window, a group titled 
New Group is now highlighted for editing. 

2. Type “Geology” as the group name, and then press ENTER or 
click in the reference list area to save the change. The 
reference list is blank, as there are no references in this new 
group.

3. Click on the All References group to display the entire library 
again.

4. In the Journal column, look for the first two references to 
Sedimentary Geology, and highlight them. To select non-
contiguous references, hold down the CTRL key as you click 
on them.

5. Drag the selected (highlighted) references to the new 
Geology group and drop them on the title of the group. (Or, 
you could go to the Groups menu and choose Add References 
To>Geology.)
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6. Click on the Geology group to display the two references now 
included in the group.

Click on All References to display all of the references in the 
library again.

To delete a group:

1. Right click on the Geology group name to display a context-
sensitive menu, and select Delete Group. 

(Or, you could click on the group name and then select Delete 
Group from the Groups menu.)

2. When you are asked to verify the deletion, click Delete.

Only the Group subset is deleted; no references are deleted from 
your library.

Many of the commands for managing groups are available both 
from the Groups menu and from the right click context-sensitive 
menu.

If you do not want to continue with the next chapter (Setting 
EndNote Preferences), go to the File menu and choose Exit to 
close the program. Otherwise, you can continue with the tour.
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Related 
Sections in the 
Full Manual

See these sections in the full EndNote.PDF manual for 
information related to this portion of the tour:

Learn how to change the display of the Library window in 
Chapter 4, “The EndNote Library.”

To learn more about sorting, see “Sorting the Library” in 
Chapter 8.

To learn more about creating and managing groups, see 
Chapter 9, “Using Groups.”
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Chapter 3: Setting EndNote Preferences
In this part of the guided tour you will learn how to:

Display EndNote Preferences

Set a favorite library to open each time you start EndNote.

Change the display fonts.

Open the 
Sample 
Library

If EndNote is not already running, start it and open the sample 
library (Sample_Library.enl) as shown under “Start EndNote” on 
page 25.

Access 
EndNote 
Preferences

To view or change the EndNote preferences:

From the Edit menu, choose Preferences.

Many of these preferences are stored in your Windows registry, 
although there are exceptions.

Set a Default 
Library

You can assign a library to open automatically every time you 
start EndNote. You will find it useful to set the sample library 
(Sample_Library.enl) as your favorite library for now. Later, 
when you create your own library, you can set it as the favorite 
library. 

To set a favorite library:

1. If you haven’t already, go to the Edit menu and choose 
Preferences. 

2. In the list on the left, click Libraries.

3. Next to “When EndNote starts,” use the drop-down list to 
select “Open the specified libraries.”
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4. Click Add Open Libraries. You should see the full path and 
filename of the sample library (Sample_Library.enl) listed at 
the top of the box.

5. Click Apply to save this change. 

While you could click OK to leave the Preferences dialog, we are 
going to change another preference first.

Change the 
Library 
Display Font

Next, pick a different font to display text in the Library window 
and the Reference window. 

To change the display fonts:

1. If you aren’t currently viewing the EndNote Preferences 
window, go to the Edit menu and choose Preferences. 

2. In the list on the left, click Display Fonts.

The Library font determines the font and size of the 
references listed in the Reference List pane of the Library 
window. 

The General font changes the font used to display most 
text that is typed into EndNote (such as in the Reference 
or Style windows). The General font is also used for most 
of the previews and information panels in EndNote, as 
well as for bibliographies that are printed or copied 
directly from EndNote. 

The Labels font determines the font and size used for the 
Reference window field labels. 
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The Search font determines the font and size applied to 
user-entered text on the Search tab.

3. On the Library tab, click the Change Font button. 

4. In the Font list, select Arial Unicode MS (or another Unicode 
font that supports Japanese characters) and click Apply to 
save the change.

EndNote uses Unicode to correctly handle extended 
characters. By selecting a Unicode font here, you can view 
extended characters in the Library window, such as the 
Japanese characters found in the sample library.

5. On the General tab, click the Change Font button. 

6. In the Font list, select Arial Unicode MS (or another Unicode 
font that supports Japanese characters) and click Apply to 
save the change.

7. Click the red close button or OK to leave the Preferences 
dialog.

Related 
Sections in the 
Full Manual

See these sections in the full EndNote.PDF manual for 
information related to this portion of the tour:

Learn how to change the display of the Library window in 
Chapter 4, “The EndNote Library.”

The Preferences panels provide many ways to customize 
your version of EndNote. For example, you can ignore 
articles when sorting, set duplicate detection options, etc. 
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See Chapter 19 for more information about setting 
preferences.
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Chapter 4: Entering a Reference
In this part of the guided tour you will learn how to:

Enter a reference into a library.

Attach a figure and other types of files to a reference.

In this part of the tour, you are going to enter a journal article 
reference that includes attached files.

Open the 
Sample 
Library

If EndNote is not already running, start it and open the sample 
library (Sample_Library.enl), as shown in Part I of the guided tour.

Create a New 
Reference

There are various ways to add references to an EndNote library:

Type the reference information into the Reference window.

Connect to an online bibliographic database and retrieve the 
references directly into EndNote, as demonstrated in 
Chapter 5: “Searching an Online Database.”

Import text files of references that have been downloaded 
from online bibliographic databases, as demonstrated in 
Chapter 6: “Importing Reference Data into EndNote.”

This example demonstrates how to type reference information 
into EndNote.

Once a library is open, you can add a new reference to it:

1. Click in the reference list and then, from the References menu, 
choose New Reference (CTRL+N). An empty Reference 
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window opens with the words “New Reference” displayed 
at the top.

New references appear as journal articles (unless you change 
the default setting) but can be changed to any other type of 
reference using the Reference Type list at the top of the 
window.

2. Next, choose a reference type. Click the Reference Type list 
and choose Book.

Notice that the field list changes to reflect the type of 
bibliographic information you would record for a book. You 
are welcome to select other reference types from the list to 
see how the list of fields changes for each type of source.
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Three reference types—Figure, Chart or Table, and 
Equation—are available specifically for cataloging picture 
files and object files, although you can add File Attachments, 
Figures and Captions to any reference type.

When you are done looking at different reference types, set 
the reference type back to the Journal Article reference type. 
You are now ready to enter reference information, beginning 
with the author names. 

3. Enter author names for the reference. Individual author 
names must be entered one per line.

a. Enter a personal author name with the first name first. 
With the cursor in the Author field, type:

Tiberius Rex

As you type, EndNote suggests names similar to the one 
you are entering. This is EndNote’s way of using term 
lists to facilitate the process of entering new references. 

NOTE: The auto-complete feature can be turned on or off with EndNote 
Term List preferences. It is available for Author fields when you enter 
author names with the last name first.

The name you are entering, Tiberius Rex, is a new author 
in this library, so keep typing until you complete the 
name and then press the ENTER key. 

The name appears in red text to indicate that it is a new 
name in the Author term list for this library. When you 
close the reference, it will be added to the Author term 
list and the red text will change to black. You can read 
more about term lists (and how to turn these options on 
or off) in Chapter 10 of the full EndNote.PDF manual.

b. Enter the second author’s name, but with the surname 
first:

Roe, Jennifer

This author is already in the sample library, so as you 
start typing the last name, you will see EndNote 
complete the name for you.

Press ENTER to accept EndNote’s suggested author name.

c. For the third author, enter:

de Young, John Robert, Jr.
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The first comma separates the last and first name. The 
second comma is inserted before suffix text, to make it 
clear that it is not part of the author’s name for 
manipulation of name order or stripping to initials. 
Suffix text will always print after the other information 
for this author.

d. Enter the fourth author’s name, which in this case is a 
corporate author:

University of California,, Berkeley

Corporate author names are entered with a following 
comma, so they will not be manipulated like personal 
author names. In this case, the corporate author name 
has a comma within the name. We inserted two commas 
to allow for correct formatting. The first comma makes it 
clear that text up to that point should not be 
manipulated, and the second comma indicates that there 
is no “first name,” yet includes suffix text.

4. Press TAB to accept the author name and move to the Year 
field. In the Year field, type: 

2006

5. Continue entering the reference as shown below, using the 
TAB key to move to the next field, and SHIFT+TAB to move to 
the previous field, if necessary. You can also use the mouse 
to click in the desired field. If information is not provided for 
a particular field, leave that field empty.

Title: The scale and the feather: A 
suggested evolution

Journal: Paleontology

Volume: 3

Issue: 1

Pages: 125-128

Date: November 22

Keywords: Feathers
Evolution
Birds

No extra punctuation (such as parentheses around the year) 
or text styles (such as bold or italic) are entered into the 
reference. EndNote adds the necessary punctuation and text 
style changes to the references when it creates a 
bibliography. 
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While we are not entering any text into the Abstract or Notes 
fields, you could enter 64 K into each of these fields, which 
amounts to 10-12 pages text.

6. Next, attach a PDF file to the reference. You can attach just 
about any type of file to the File Attachments field of a 
reference.

Scroll to the File Attachments field, and from the References 
menu, select File Attachments and then Attach File to display 
a file dialog. On the file dialog:

a. Navigate to the folder Program Files\EndNote X2. 

b. Notice the check box titled “Copy this file to the default 
file attachment folder and create a relative link.” Make 
sure this box is selected so that EndNote will make a 
copy of the file to store with the library. That way, the 
attached file is always available to you, even when you 
move the library.

c. Highlight the file titled EndNote.PDF. This is the full 
EndNote manual located in the EndNote program folder. 

d. Click Open to insert the file into the File Attachments 
field. A file icon will appear in the field.

You can attach up to 45 different files to a single 
reference, and you can double click a file icon to open the 
file with the default application. 

7. Next, attach a figure file. Attached figures can be cited and 
displayed in Microsoft Word, which we will do later in the 
tour. You can attach a single figure file to each EndNote 
reference.

Microsoft Word recognizes many file types as figures. Some 
valid file types include these graphic files:

Windows Bitmap (BMP)
Graphics Interchange Format (GIF)
JPEG File Interchange Format (JPEG)
Portable Network Graphics (PNG)
Tag Image File Format (TIFF)

You can also insert object files, such as:

Audio files (WAV, MP3)
Microsoft Access files
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Microsoft Excel files
Microsoft Power Point files
Microsoft Project files
Microsoft Visio files
Microsoft Word files
Multimedia files (MOV, QuickTime)
Technical drawing files
Text files (TXT, RTF, HTML)

Scroll to the Figure and Caption fields, and from the 
References menu, select Figure and then Attach Figure. 

Click Choose File to display a file dialog.

On the file dialog:

a. Navigate to the folder: Program Files\EndNote X2\
Examples. (The Examples folder found here is a shortcut 
to a shared location.)

b. Highlight the file titled Feather2.BMP. 

c. Click Open to insert the file into the Figure field.
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The graphic appears as a thumbnail in the reference. 
EndNote copied the file to a .DATA folder stored with the 
Sample_Library library, and linked the copied graphic to this 
reference.

In the Caption field, enter:

Cockatiel Crest Feathering

Always enter a caption for your image. It assists in locating 
images, and it labels figures in your Microsoft Word 
documents.

8. Close the Reference window by clicking the close box (the X 
in the upper right corner of the Reference window), or by 
choosing Close Reference (CTRL+W) from the File menu.

All information is automatically saved when you close the 
reference window. Your new reference will appear in the Library 
window.

A paper clip icon appears next to the reference to indicate an 
attached file. You could also modify the reference list to show a 
column for attached figures, but that is not a default setting.
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Locate 
References 
That Contain 
Attached Files

You can easily locate those references that contain attached files.

To locate the references containing attached files:

Click the paper clip icon in the first column heading twice to sort 
records containing attached files at the top of the list. References 
that include a paper clip have one or more attached files.

You can double-click on an individual reference if you would 
like to view the complete reference. When you are done viewing 
a reference, click the close button to close it.

Click the Author column heading to again order the list by 
author names in ascending (A to Z) order.

This concludes Chapter 4 of the guided tour. Chapter 5 
demonstrates how to search remote databases and save your 
search results to an EndNote library. If you do not have an 
Internet connection, skip Chapter 5 and move on to Chapter 6: 
"Importing Reference Data into EndNote" on page 57.

If you are finished working with EndNote for now, go to the File 
menu and choose Exit to close the EndNote program.

Related 
Sections in the 
Full Manual

See these sections in the full EndNote.PDF manual for 
information related to this portion of the tour:

If you are eager to begin creating your own library, see 
Chapter 4, “The EndNote Library.”

Chapter 5, “Entering and Editing References,” provides 
more detail about typing references into your library and 
inserting images.
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Chapter 5: Searching an Online Database
With the EndNote Online Search command, you can search online 
bibliographic databases just as easily as you can search an 
EndNote library on your own computer. And to make it even 
easier, the results of your searches are saved as references in 
your own EndNote library. 

This section will guide you through these basic steps:

Connect to an online database.

Search the database and download the references into an 
EndNote library.

NOTE: In order to follow this exercise, you must be at a computer with 
access to the Internet (either dial-up or a direct network connection).

About the PubMed Database
For this lesson, you will connect to PubMed, the National Library 
of Medicine’s online public access version of their MEDLINE 
database. PubMed is the online database you will be searching; 
the National Library of Medicine is the information provider.

For Users With “Dial-up” Internet Connections
If you use a modem and a phone line to connect to the Internet, 
as opposed to a direct network connection, this section pertains 
to you.

Connecting: Most setups for dial-up connections are configured 
to automatically dial your information provider and connect to 
the Internet when you use an application that requests an online 
connection (as EndNote’s Online Search command does). 
However, some setups require that you establish an online 
connection (sign on) before choosing EndNote’s Online Search 
command. 

Disconnecting: EndNote disconnects from an online database as 
soon as a search is completed, but will not disconnect your 
Internet connection at any point. You need to shut down your 
connection when you have finished using EndNote’s Online 
Search feature.

Open the 
Sample 
Library

If EndNote is not already running, start it and open the sample 
library (Sample_Library.enl), as shown under “Start EndNote” on 
page 25.
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Connect to an 
Online 
Database

The first step in searching an online database is connecting to it.

To connect to the PubMed Database:

1. Go to the Tools menu and select Online Search to see the 
available list of online databases. You could also look under 
Online Search in the Groups pane and click more.

(The Groups pane will remember databases you have 
connected to in the past for easy access under Online Search. 
You can also customize a list of favorite databases to search 
by using the Connection Manager.)

NOTE: This window displays all of the connection files available in your 
Connections folder. Use the Find by button to quickly view various 
categories of databases to help you locate the one that you need. Or, 
type text into the Quick Search text box and press Enter.

2. Select the PubMed connection file (you can start typing the 
file name to quickly jump to it in the list), and click Choose.

By selecting that connection file, you have directed EndNote to 
connect to the National Library of Medicine’s PubMed database. 
If for any reason the connection cannot be established, EndNote 
alerts you with an error message and closes the connection.

Click to 
show more 
or less info 
about the 
selected 
connection 
file.
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When the connection has been established, EndNote displays a 
Search tab. Note that the search tab is titled, “Online Search - 
PubMed MEDLINE at PubMed (NLM).” The PubMed MEDLINE 
database is selected and EndNote is ready to search.

NOTE: If you previously set a default configuration for the Search tab, 
the search field lists display the fields you selected as your defaults. If 
one of these fields appears italicized in the Search tab lists, that 
indicates it is not a valid option for this particular online database.

Search the 
Database

The next step is to enter the search term(s) to find the references 
you need. Searching an online database is very similar to 
searching an EndNote library, with a few exceptions. 

Let’s say you are interested in finding more information about 
fossils for the sample library. 

To enter the search term(s) and perform the search:

1. Set the field list for the first line to Keywords (MeSH), and 
enter “fossil” into the search text field. The comparison list 
for online searches is always set to Contains.

2. Click Search. 

field list comparison list search term

logical 
operator 
lists

Match Case and Match Words are not available for online searches
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EndNote sends the search request off to the online database 
(PubMed MEDLINE, in this example), and a summary of the 
search results is displayed:

The dialog displays the number of references that were 
found to match your search request, and gives you the 
option to retrieve them. 

NOTE: PubMed is updated regularly, so you may find a different 
number of references than illustrated here.

If the result set seems too big, you can always refine the 
search to get closer to exactly those references you want. 
Let’s refine this search by looking for just those references 
that include mention of a “trilobite,” a group of extinct 
marine animals that were abundant in the Paleozoic era.

3. Click Cancel, and you are returned to the Search tab.

4. Set the operator at the beginning of the second search line to 
And.

5. In the second search line, select Any Field from the field list 
and type “trilobite” as the search text.

6. Click Search.
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This time only 14 references were found.

7. For our purposes, limit the download even further. Change 
the number in the second box to “10” to limit our download 
to the first 10 records.

8. Click OK to retrieve and save the matching references. 

The references are downloaded into your library and appear 
both in the All References group and in a temporary group 
for the PubMed database connection. 

You can halt a retrieval in progress by clicking the Cancel 
button on the Search tab. Records that have been processed 
up to that point already exist in the library.

The temporary PubMed (NLM) group will reset back to 0 
references when you close the library.
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Review the 
References

At this point you can peruse the retrieved references to make 
sure you want to keep all of them. You may find that some of the 
references are not helpful for your research.

While you could open each reference individually to scan 
through the bibliographic data, you can also use the Preview tab.

To quickly look at the new references:

1. Click on a reference in the reference list.

2. In the Tab pane, click on the Preview tab to display a 
reference preview.

3. On the toolbar, select the Show All Fields output style from 
the output style list.

The Show All Fields style is not bibliographic, but represents 
all of the fields in your references. On the Preview tab, you 
can scroll through the data in the selected reference.

Delete 
Unwanted 
References

Once you identify references you do not want, you can delete 
them.

To delete references:

1. In the PubMed (NLM) group, select two of the displayed 
references by holding down the CTRL key and clicking on the 
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individual references. (Use SHIFT+click, or click and drag, to 
select a range of references.) 

2. From the References menu, select Move References to Trash. The 
selected references are removed from the library and put in 
the Trash group.

While the references are officially no longer in your library 
(they will not appear in any other group or reference list, 
they are not included in your reference count, and they 
cannot be cited), they are not completely deleted until you go 
to the Groups menu and choose Empty Trash. Until you 
choose Empty Trash, you can still drag references from the 
Trash group back to your active library.

3. Because you are sure that you want to delete the references, 
click on the Trash group and then go to the References menu 
to select Empty Trash.

4. Confirm the deletion by clicking OK.

5. Click the All References group to return to the full reference 
list, and on the toolbar, set your output style back to 
Numbered.

If you wanted to do another search of PubMed at this point, you 
could display the PubMed group, enter another search strategy, 
and click Search again. On the Confirm Online Search dialog, you 
are asked, “Clear currently displayed results before retrieving 
records?” This check box simply removes the previous 
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downloaded references from the PubMed group; they still exist 
in the library. It is an easy way to see just those references 
downloaded with the current search strategy.

This concludes the tutorial for using EndNote’s Online Search 
command. 

If you are finished working with EndNote for now, go to the File 
menu and choose Exit to close the EndNote program.

Related 
Sections in the 
Full Manual

See these sections in the full EndNote.PDF manual for 
information related to this portion of the tour:

See Chapter 6 for details about establishing connections, 
searching for references, and retrieving references.

Read “Selecting a Connection File” in Chapter 6 to learn 
about the connection files that are available with EndNote. 

See “Troubleshooting Connections” in the Troubleshooting 
appendix if you encountered any problems establishing a 
connection.

See Chapter 18, “Connection Files” for information about 
creating and editing connection files.
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Chapter 6: Importing Reference Data into 
EndNote

Online searching, described in the previous section, is the easiest 
way to retrieve references from online databases, but not all 
information providers offer that option.

If you have access to an online bibliographic database or 
university catalog, you can probably use EndNote’s import 
filters to import text files saved or downloaded from these 
sources. EndNote filters are configurable, so they give you the 
flexibility to import the reference data you need and eliminate 
data you do not need. 

In this part of the guided tour you will learn about:

Downloading data in a tagged output format.
Selecting an import filter and importing data into EndNote.

Open the 
Sample 
Library

If EndNote is not already running, start it and open the sample 
library (Sample_Library.enl), as shown under “Start EndNote” on 
page 25.

Search the 
Database and 
Save the 
References

Often when you search a database, the matching references are 
displayed as text, with no clear indicator between each piece of 
bibliographic information. The PubMed reference below, saved 
in a Citation format, is an example. There is no clear indicator for 
EndNote to be able to differentiate a title from an address or an 
abstract.

Am J Med Genet A. 2005 Mar 9; [Epub ahead of 
print]  

Reconstructing the behaviors of extinct 
species: An excursion into comparative 
paleoneurology.

Rogers SW.

    Salt Lake City VA-Geriatrics Research, 
Education and Clinical Center and Department 
of Neurobiology and Anatomy, University of 
Utah School of Medicine, Salt Lake City, Utah.

    How can the behavior of an extinct species 
be reconstructed-say a dinosaur such as 
Allosaurus? Despite the relatively abundant 
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fossilized remains of this and other 
dinosaurs, the incompleteness of the fossil 
record has permitted room for considerable 
speculation, mythology, and perhaps a bit of 
unsettling reflection on what factors 
contributed to the eventual fate of these 
remarkably successful animals. (continued) 
(c) 2005 Wiley-Liss, Inc.

PMID: 15759265 [PubMed - as supplied by 
publisher]

To use this information effectively, each piece of bibliographic 
information must be consistently tagged so it can be directed to 
the correct EndNote field.

Database providers typically offer several different download 
formats. Regardless of which system you are searching, you need 
to save the references in a tagged format to a text file.

For this tour, we will use a text file of PubMed references that 
were previously downloaded in the tagged MEDLINE format. 
The file Pubmed-dinosaur.txt is provided in the EndNote 
Examples folder. A single reference in the file appears like this:

PMID - 15759265
OWN - NLM
STAT - Publisher
DA - 20050310
PUBM - Print-Electronic
IS - 1552-4825
DP - 2005 Mar 9
TI - Reconstructing the behaviors of extinct 

species: An excursion into comparative 
paleoneurology.

AB - How can the behavior of an extinct species 
be reconstructed-say a dinosaur such as 
Allosaurus? Despite the relatively 
abundant fossilized remains of this and 
other dinosaurs, the incompleteness of 
the fossil record has permitted room for 
considerable speculation, mythology, and 
perhaps a bit of unsettling reflection on 
what factors contributed to the eventual 
fate of these remarkably successful 
animals. (continued) (c) 2005 Wiley-Liss, 
Inc.
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AD - Salt Lake City VA-Geriatrics Research, 
Education and Clinical Center and 
Department of Neurobiology and Anatomy, 
University of Utah School of Medicine, 
Salt Lake City, Utah.

AU - Rogers SW
LA - ENG
PT - JOURNAL ARTICLE
DEP - 20050309
TA - Am J Med Genet A
JID - 101235741
EDAT - 2005/03/11 09:00
MHDA - 2005/03/11 09:00
AID - 10.1002/ajmg.a.30538 [doi]
PST - aheadofprint
SO - Am J Med Genet A 2005 Mar 9;.

Each tag can be mapped to a corresponding EndNote field. If 
data is inconsistently tagged, or poorly delimited, it may not be 
possible to import all the data accurately. 

Choose the 
Correct Import 
Filter and 
Import into 
EndNote

Once you have captured and saved your data file in a tagged 
format, you need to identify the proper EndNote filter to import 
the data. There are hundreds of filters included with EndNote; 
each one is designed to read a specific tagged format from a 
specific information provider.

To import the sample PubMed text file into the sample library:

1. View the Library window in EndNote.

2. From the File menu, choose Import. 

3. Click the Choose File button to display a file dialog.

4. Browse to the EndNote X2\Examples folder and then 
highlight and Open the Pubmed-dinosaur.txt file.
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5. From the Import Option list, select Other Filters to display the 
list of filters supplied in the EndNote Filters folder. (You 
may experience a delay before EndNote displays the full list 
of filters.)

You may want to peruse the list, to get an idea of what filters 
are supplied. You can create new filters or copy and edit 
existing filters.

6. Begin typing “PubMed” to jump to that filter in the list.

If the More Info button is available, click it and notice that the 
Comments section at the bottom of the window gives tips for 
downloading references from the selected source.

7. With the PubMed (NLM) filter highlighted, click Choose.

8. Leave the other two options at their default settings:

Duplicates: Import All

By default, a reference is considered a duplicate if the 
Author, Year, Title, and Reference Type match a reference 
already in the library. You can change the duplicates criteria 
under EndNote Preferences. We will import all references 
regardless of duplicates.
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Text Translation: No Translation

This option allows you to specify the text character encoding 
of the file you import. This is important when you import 
references in languages that include extended characters. 
You would typically contact your database provider for the 
appropriate setting.

9. Click Import to import the file.

When the process is complete, only newly imported 
references display in the reference list. This is a good time to 
peruse the new references to make sure they imported as 
expected. You can display the Preview tab to view the 
formatted references, you can open individual references to 
make sure all information transferred to the correct fields, 
and you can easily edit or delete the new references.

Notice that the focus in the Groups pane has switched from 
the All References group to a new Imported References 
group. 

The Imported References group is a temporary group. It is 
replaced each time you import a new set of references, and it 
is removed when you close the library. The references 
themselves remain in the library unless you specifically 
delete them.

10. To return all of your references to the library display 
(including the newly imported references), choose Show All 
References from the References menu or click on the All 
References group.
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Summary of 
Output 
Formats and 
Corresponding 
Import 
Options

A subset of supported information providers are listed here with 
their recommended output formats. Check this list for guidance 
in order to download in the appropriate tagged format and select 
the appropriate import filter. This information was accurate at 
the time of publication, but you may need to contact your 
information provider if changes occur. You can also check our 
website at http://www.endnote.com for updated information 
and import filters.

NOTE: Some of the services listed in this table, such as EBSCO and 
WilsonWeb, have an alternate, easier way of transferring references 
into an EndNote library. See “Direct Export from Web Pages” on page 
67.

Copyright Issues and Fair Use of Downloaded Data

EndNote gives you the capability to import references downloaded from 
online databases into its libraries. Some producers of online reference 
databases expressly prohibit such use and storage of their data; others 
charge an extra fee for a license to use the data in this way. Before you 
download references from a database, be sure to carefully check the 
copyright and fair use notices for the database. Note that different 
databases may have varying restrictions, even from the same information 
provider (such as DIALOG or Ovid). 
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Output Formats and Corresponding Import Options

Information Provider Recommended Download Format Import Option

AARP AgeLine
(http://
research.aarp.org/
ageline/home.html)

There is no method for downloading data from this 
database. Instead, save the results screen as a plain text 
file with your web browser’s Save command. The 
resulting text file contains tags which are preceded by 18 
spaces.

Ageline (AARP) filter

ACM Digital Library
(Association for 
Computing Machinery)

Users with subscription access to this website can save 
multiple records to a BINDER. Once saved, you can 
export the records in an EndNote format.

Non-subscribers can download one record at a time: 

1. Create a search.

2. Click on an article.

3. Scroll half-way down the page and select DISPLAY 
EndNote.

Limitations:

Since only plain text files can be imported into EndNote, 
you cannot import images, graphics, etc.

Before importing, you may need to edit the file to insert 
a comma after corporate author names. Otherwise, 
EndNote will not be able to distinguish corporate authors 
from personal authors.

EndNote Import

CAS SciFinder Save references in the “Tagged Format” (*.txt). SciFinder (CAS) filter

CSA 
(formerly Cambridge 
Scientific Abstracts)

From the CSA search results screen, click Save/Print/
Email. On the “Save/Print/Email” screen, select:

Record Format: Full Record
Save File Format: PC

Click Save. Your Web browser asks where to save the 
file. If your Web browser lets you save in different file 
formats, make sure you save as a “Text Only” (*.txt) file.

Various filters for CSA 
databases are provided 
in the EndNote Filters 
folder.

DIALOG Set your communication software's option to capture 
text. Use Dialog's Format 5 with "tag" appended to the 
TYPE command -- type "s1/5/1-20 tag". 

You must download data in Format 5. If Format 5 is not 
available, try the “full” format, which is sometimes the 
same as Format 5. For questions concerning Dialog’s 
many formats, please contact Dialog's tech support.

Various DIALOG 
filters are provided in 
the EndNote Filters 
folder.

DIMDI Use the DLOAD command with report D1 
(e.g. DLOAD REPORT=D1).

Various DIMDI filters 
are provided in the 
EndNote Filters folder.
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EBSCOhost After adding selected references to your folder, click 
“View Folder” or “Folder has items” to see its contents. 

On the Folder Content page, click Export. On the Export 
Manager page, select “Generic bibliographic 
management software" to save a file to disk. Click Save.

Various EBSCO filters 
are provided in the 
EndNote Filters folder.

EDINA Use the “Name” format, where data is tagged with words 
such as “Author” rather than “AU.”

Because there are so many different formats used for 
source data, you may need to manually edit source data 
after importing.

EndNote cannot parse author names that are not clearly 
delimited, such as 
“S Hughes B Reynolds S A Bell & C Gardner.” You will 
need to manually edit author names.

Various EDINA filters 
are available in the 
EndNote Filters folder.

Emerald Display the marked list, click “display for download 
(ASCII),” and then save as a plain text file.

The filter provided works for these Emerald databases:

Emerald Management Reviews at 
http://www.emeraldinsight.com/revs/

Computer Abstracts International Database at http://
www.emeraldinsight.com/caid

International Civil Engineering Abstracts at 
http://www.emeraldinsight.com/icea/

Computer & Communications Security Abstracts at 
http://www.emeraldinsight.com/ccsa/

Current Awareness Abstracts at 
http://www.emeraldinsight.com/caa/

Limitations:

Page numbers are separated by a hyphen with spaces on 
either side of it. You will need to manually remove the 
spaces after importing. 

Emerald filter

InfoTrac 
(Gale)

From the E-Mail Delivery panel at the bottom of the 
marked list window, restrict the contents to “citation;” do 
not choose “full article.”

Limitations:

Records often have extraneous information in the title 
field, which must be removed manually after importing.

InfoTrac (GALE) filter

Output Formats and Corresponding Import Options

Information Provider Recommended Download Format Import Option
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INIST 1.  Click the Enregistrer button.

2.  Select the records you wish to download. 

3.  Under “Quels champs?” choose "Tous les champs."

4.  Under “Incluez” choose "Numéro de notice et nom de 
la base de données" and "Libellés abrégés."

5.  Click the Sauvegarde de notices button.

Various INIST filters 
are provided in the 
EndNote Filters folder.

INNOPAC Save references in the “EndNote” format. EndNote Import

Knowledge Finder Place document in the Save file, and select the document. 
Choose Export Selected Documents from the File menu.

Various Knowledge 
Finder filters are 
provided in the 
EndNote Filters folder.

Medscape After selecting the desired records and adding them to 
your clipboard, click the Save or Email Clipboard link. 
Save or email your clipboard in PC or Mac MEDLARS 
format as a plain text (*.txt) file.

MEDLINE (Medscape) 
filter

NERAC Save your file as plain text (*.txt). NERAC

OCLC FirstSearch 1. Mark the records you wish to download.

2. In the navigation pane, click Export.

3. Click the radio button next to “The marked records” or 
“A range of records.”

4. Click the radio button next to “EndNote.”

5. Click Export and save to a Text file.

Various OCLC filters 
are provided in the 
EndNote Filters folder.

Ovid 1. After selecting the references you wish to download, 
click Results Manager. 

2. Choose the following options:

Fields:  Complete Reference

Citation Format:  Reprint/Medlars (or     Direct 
Export, if available)

3. Click the Email or Save button. 

4. Save the file as plain text (*.txt).

The appropriate Ovid 
filter will be selected 
automatically when 
using the Direct Export 
option. If you are using 
Ovid's multiple 
database searching, you 
must select the Direct 
Export citation format.

Output Formats and Corresponding Import Options

Information Provider Recommended Download Format Import Option
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ProQuest 1. Select the desired references and then click the “My 
Research Summary” tab.

2. Click the “Documents and Bibliography” tab.

3. Choose “Export,” then either “Export directly to 
ProCite, EndNote or Reference Manager,” or “Download 
in a format compatible with ProCite, EndNote, Reference 
Manager and RefWorks.” If you choose the former, make 
sure your data is displayed in a tagged format before 
saving as a text file.

ProQuest filter

PsycINFO 
http://www.apa.org/
psycinfo

After marking the records you wish to download, choose 
Full PsycINFO Record then click the Display Marked 
Records button. Select the text, then copy and paste it 
into a text editor, saving the file as plain text (*.txt).

Use the PsycINFO 
(APA) filter.

PubMed 1. From the drop-down menu next to the Display button, 
choose MEDLINE.

2.  From the “Send to” menu, choose File and save the 
file as a plain text file (*.txt).

Note that the PMID will transfer to the Accession 
Number field in EndNote.

PubMed (NLM) filter 

SilverPlatter WebSPIRS 1. Once you've obtained your search results, click Save. 

2.  Select the following “Save Records” options:

Which fields?: All fields

Include: Record number and database name

Field labels: Short labels.

3. Click the Save Records button. 

4. Use your Web browser to save the page as "Text Only" 
(do not save in HTML format).

Various SilverPlatter 
filters are provided in 
the EndNote Filters 
folder.

STN Set your communication software’s options to capture 
text to a file. Type the command “Display All”.

Various STN filters are 
provided in the 
EndNote Filters folder.

UnCover (Ingenta) Using your email software, save references emailed to 
you as a "Plain Text" or "Text Only" file.

UnCover (INGENTA)

VHL
(Virtual Health Library)

1. After selecting the desired references, scroll to the 
bottom of the page and click “Your collection” (or “Su 
selleccíon”).

2. Cancel the print dialog, and then save the screen as a 
plain text file.

Various VHL filters are 
provided in the 
EndNote Filters folder.

Output Formats and Corresponding Import Options

Information Provider Recommended Download Format Import Option
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Direct Export 
from Web 
Pages

Certain websites contain a download button that will send your 
search results directly to EndNote, pick the correct import filter, 
and start the import process automatically. Start by opening the 
EndNote library into which the data should be imported. This 
“direct export” or “direct download” method does away with 
the additional steps of saving the references to a text file, and 
then importing that file with the appropriate filter. 

The systems listed below provide a direct export of references 
into EndNote. A detailed table of instructions can be found in 
Appendix D of the full EndNote manual. The list keeps growing, 
so contact your information provider to find out whether they 
participate!

Web of Knowledge
Web of Science

Display your marked references. Then, look under 
Output Records and select the option to output Full 
Records. Next, click Export to Reference Software to 
have the references exported directly to EndNote. You 
may also choose Save to File to save the references to a 
text file and import them into EndNote.

ISI-CE filter

Wilson 1. Click Print Email Save. 

2. Click Export to Bibliographic Software. 

3. Choose The EndNote Filter and click Export.

4. Save to a text file.

WilsonWeb filter

WorldCat 
(OCLC FirstSearch)

1. Mark those references to be saved and click Export.

2. Choose Text File. 

3. Click Export.

WorldCat (OCLC) filter

Output Formats and Corresponding Import Options

Information Provider Recommended Download Format Import Option

ALEPH Los Alamos National Laboratory
American Psychological 
Association, PsycInfo Online

MicroPatent

Bibliotech.dk Nature
BioMedCentral Nerac
BioOne NISC
Blackwell Synergy OCLC
BMJ OhioLink
Buffalo University OVID
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This concludes the tutorial for using EndNote’s Import 
command. 

If you are finished working with EndNote for now, go to the File 
menu and choose Exit to close the EndNote program.

Related 
Sections in the 
Full Manual

See these sections in the full EndNote.PDF manual for 
information related to this portion of the tour:

See Chapter 7, “Importing Reference Data into EndNote,” for 
details about import options and about importing references 
from other bibliographic software programs.

Read Chapter 17, “Filters,” to learn how to create or modify 
filters that map downloaded references to corresponding 
fields in EndNote. You can enter tags and map them to 
specific EndNote fields.

See Appendix D, “Direct Export Formats and Import 
Formats” for detailed tables of instruction for importing 
reference data from various online systems.

CABI-Direct Oxford Press Journals
Canadian Journal of 
Communication

Pacific Northwest Labs

CCLR Patent Cafe
Delphion PILOTS
EBSCO PNAS Online
EI Engineering ProQuest
Elsevier RLG
EMBASE Science Magazine
ERIC Scopus
ESDS Government St. John of God, Ireland
Google Scholar Stanford University's Highwire Press
HAPI Telemed
IEEE Thieme
JAMA Web of Science
JISC WebFeat
JSTOR WilsonWeb
Karger Publishing
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Chapter 7: Searching an EndNote Library and 
Previewing a Bibliography

In this part of the guided tour you will learn how to:

Search an EndNote library for a subset of references.

Preview a bibliography in EndNote.

In this part of the tour, you will search for a set of related 
references and preview them formatted in a bibliographic style. 

Open the 
Sample 
Library

If EndNote is not already running, start it and open the sample 
library (Sample_Library.enl), as shown under “Start EndNote” on 
page 25.

Search for a Set 
of References

Let us assume that you want to generate a list of all references 
found in the sample library about extinction that were published 
from 1990 to 1999.

To search for references:

1. Make sure that the All References group is displayed.

2. In the Tab pane, display the Search tab.

3. The Search tab remembers the last search you entered. To 
clear it, use the Options button to select Restore Default.

4. On the first search line:

a. In the first drop-down list, the field list, select Any Field. 
This means that EndNote will search all fields. 

b. In the next drop-down list, the comparison list, the 
Contains comparison operator means that EndNote will 
search for the string of text anywhere in the field.
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c. Type “extinct” as the first search term.

Next, set up the search to find references dated from 1990 to 
1999. 

5. From the field list in the second search line, choose Year; 
from the comparison list, choose Is greater than or equal to; 
and type 1990 as the search term for the second search line.

6. If you do not have a third search line available, click the plus 
sign button (+) next to the last search line to insert another 
line. You can also click and drag the top of the pane to view 
more of the Search tab.

7. From the field list in the third search line, choose Year; from 
the comparison list, choose Is less than or equal to; and type 
1999 as the search term. 

8. Notice the “And, Or, Not” logical operator list at the 
beginning of each search line. Select the “And” logical 
operator between the three search lines. 

Your search tab should look like this:

This search will find all references containing the text 
“extinct” that also were published between 1990 and 1999. 

Notice that the following check boxes are not selected for this 
search:

Match Case: This option would limit our search to “extinct” 
in lowercase. If it were found capitalized at the beginning of 
a sentence, or all uppercase, it would not match the search.

Match Words: This option would limit matches to full 
words, with no truncation. The word “extinction” would not 
match our search. 

field list search term

logical 
operator 
lists

comparison list
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9. Click the Search button to begin the search. In a moment, 
EndNote displays the search results.

The status area at the bottom of the Library window should read, 
“Showing 5 of 5 references in Group.”

Notice in the Groups pane that these search results are 
automatically retained in a Search Results group. This makes it 
easy to display other sets of references, but still go back and 
display your most recent search results. This temporary Search 
Results group will be replaced the next time you run a search on 
the library. When you close the library, this group is removed.

Now that you have located all of the desired references, you are 
ready to preview them. 

Preview the 
Found 
References

In order to format your references, you need to select an output 
style. Styles determine how your references look when you print, 
export, preview, or create bibliographies.

To preview the bibliography:

1. On the Main toolbar, select an output style from the output 
style list. For this example, you can leave the Numbered style 
selected. 

2. If you want to further limit the references to preview, select 
(highlight) those references you want to include. To select all 
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references in the list, first click in the list, then go to the Edit 
menu and choose Select All.

3. From the File menu, choose Print Preview to display the 
bibliography on your computer screen.

4. You can use the buttons along the top of the window to walk 
through the pages of the bibliography.

5. When you are done previewing, click the Close button.

You may want to return to the full list of references in the sample 
library. To show all references again in the library window, click 
on the All References group. 

This concludes this part of the guided tour. Chapter 8 
demonstrates how to write a paper and cite references and 
figures in Microsoft Word. 

If you are finished working with EndNote for now, go to the File 
menu and choose Exit to close the EndNote program.

Related 
Sections in the 
Full Manual

See these sections in the full EndNote.PDF manual for 
information related to this portion of the tour:

More information about searching the EndNote library can 
be found in Chapter 8, “Searching and Sorting in EndNote.”

Read Chapter 13, “Creating an Independent Bibliography,” 
about creating reference lists directly from your EndNote 
library, including printing your bibliography and saving 
your bibliography to an RTF file.

See Chapter 16, “Bibliographic Styles,” for information about 
modifying and selecting styles.
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Chapter 8: Using EndNote While Writing a 
Paper with Microsoft Word

NOTE: Continue with this part of the tour only if you use Microsoft Word 
2003 or 2007. If you use a different word processor, or if you have an 
older version of Word, turn to Chapter 12 in the full EndNote.PDF 
manual to learn how to cite EndNote references and create 
bibliographies in your papers. 

EndNote’s Cite While You Write feature inserts EndNote 
commands into Word’s Tools menu in Word 2003, or on an 
EndNote tab in Word 2007, to give you direct access to your 
references while writing in Microsoft Word. The Cite While You 
Write commands enable EndNote to do bibliographic formatting 
to the document that is currently open in Word.

In this part of the guided tour, you will learn how to:

Insert EndNote bibliographic citations into your paper and 
create a bibliography.

Edit citations to suppress author names and add cited pages.

Insert EndNote figure citations into your paper. (This section 
uses the figure reference that was inserted while following 
Chapter 4.)

Open the 
Sample 
Library

If EndNote is not already running, start it and open the sample 
library (Sample_Library.enl), as shown under “Start EndNote” on 
page 25.

EndNote will look for matching references in the currently open 
libraries. While EndNote can start and open your default library 
when needed by Word, opening the library first assures you that 
you are citing references from the appropriate library.

Open a 
Microsoft 
Word 
Document

For this tour, start Microsoft Word and open a new document. 

While we are not using one for this tour, EndNote does include 
manuscript templates that make it easy to set up your paper for 
electronic submission to a publisher. When you use one of these 
templates to start your paper, many formatting issues are 
already set up for your target publication, such as proper 
margins, headings, pagination, line spacing, title page, font type 
and size, etc. For more information about using manuscript 
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templates, see “Using Predefined Manuscript Templates” in 
Chapter 11 of the full EndNote.PDF manual.

Cite EndNote 
References

You are going to start entering text and citations. For this tour, 
you are going to enter minimal information.

To start writing your paper and inserting citations:

1. Enter text as though you were writing your paper:

The fossil in question was generally 
regarded to be the 220 million year-old 
remains of tyrannosaurus. Several years ago, 
however, Morehouse overturned this hypothesis 
with the discovery of yet another species. 

Now you are ready to insert a citation. 

2. Word 2003: From the Tools menu, go to the EndNote X2 
submenu and then Find Citation(s). 

Word 2007: On the EndNote tab, in the Citations group, click 
the Insert Citation icon.

3. The EndNote Find Citations dialog appears. Type the author 
name “Morehouse” in the “Find” box and click Search.
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EndNote lists the matching references. In this case, a single 
reference matches the search. 

4. Click Insert to insert the selected reference as a citation. There 
may be a delay the first time Word communicates with 
EndNote for the document.

EndNote not only inserts a citation, but Instant Formatting 
formats the citation in the currently selected Numbered style 
and adds it to a formatted bibliography at the end of the 
paper. 

5. Add more text to the paper:

It is now the undisputed progeny of the 
species at hand.

6. Word 2003: From the Tools menu, go to the EndNote X2 
submenu and then Find Citation(s). 

Word 2007: On the EndNote tab, in the Citations group, click 
the Insert Citation icon.
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7. Type the date “1987” into the find box and click Search. 
EndNote searches all fields and lists the matching references.

8. Scroll down the list of matching references, select the 
reference by the author Turnhouse, and click Insert.

EndNote inserts the citation, and Cite While You Write 
technology formats it and adds it to the bibliography at the 
end of the paper. 

Your document text should now look like this:

NOTE: You can shade each of the Cite While You Write citation and 
bibliography fields so they are easy to locate. This is set with Microsoft 
Word’s Field Shading option. The shading is for on-screen help only, 
and does not print.

The fossil in question was generally regarded to be the 220 

million year-old remains of tyrannosaurus. Several years ago, however, 

Morehouse overturned this hypothesis with the discovery of yet another 

species. [1] It is now the undisputed progeny of the species at hand. [2]

1. Morehouse, S.I. and R.S. Tung, Statistical evidence for early 
extinction of reptiles due to the K/T event. Journal of 
Paleontology, 1993. 17(2): p. 198-209.

2. Turnhouse, M.B., Role of 14C dating in paleontology. Journal 
of Paleontology, 1987. 75(6): p. 11-15.
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9. Assume that you have finished inserting citations in your 
paper. 

Word 2003: From Word’s File menu, choose Save to save your 
document. 

Word 2007: Click the Office icon and select Save.

NOTE: You can also insert citations in footnotes. First, use the 
appropriate Word command to create the footnote. Then, insert the 
EndNote citation in the footnote. Word controls the placement and 
numbering of the footnote, and EndNote formats the citation based on 
the current style. You must select a style that formats footnotes; for 
example, Chicago 15th A.

Select a 
Bibliographic 
Style

You can format your citations and bibliography as many times as 
you like, changing the output style and various other layout 
settings each time.

To select the bibliographic style used for formatting:

1. Word 2003: From Word’s Tools menu, go to the EndNote X2 
submenu and choose Format Bibliography. 

Word 2007: on the EndNote tab, in the Bibliography group, 
click the bottom corner arrow.
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A Format Bibliography dialog appears, where you can select 
a bibliographic style. 

Styles contain instructions for how EndNote will format 
citations and the bibliography. For the previous example, we 
illustrated the Numbered style, which sequentially numbers 
citations and then inserts a numbered reference list at the 
end of the paper. 

As you can see, there are many other formatting options 
available here; you can make changes that override the 
settings in the current output style.

2. For this example, click the Browse button next to “With 
output style” to display the list of output styles supplied 
with EndNote.

3. Select the APA 5th style and click OK.
(To locate the APA 5th style, click in the list and type “APA.” 
You can sort the list of styles by Name or by Category by 
clicking on a column header.)

4. Click OK to leave the Format Bibliography dialog.

EndNote automatically updates the existing citations and 
regenerates the bibliography in the APA style. 

In the future, if you need to make changes to the paper such as 
adding or deleting citations or text, just do the necessary updates 
in your paper. If you want to change the output style or 
bibliography layout settings, choose the Format Bibliography 
command again. EndNote will reformat the in-text citations and 
generate a new bibliography based on your changes.
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NOTE: More than 3,000 styles are installed in EndNote’s Styles folder. 
To see a list of them organized by discipline, choose Output Styles from 
the Edit menu in EndNote and select Open Style Manager. 

Edit a Citation If you directly edit a citation or the bibliography, the changes 
will be lost when you Format Bibliography again because EndNote 
reformats according to the rules of the selected output style. To 
make and retain changes to all citations and/or the bibliography, 
modify the output style. However, if you want to make a change 
to an individual citation, use the Edit Citation command as 
described below.

For some bibliographic styles, the majority of references are cited 
in an “Author, Date” format; but if the author’s name is 
mentioned within the paragraph text, the style dictates that the 
name not be repeated in the citation. In our example, we mention 
Morehouse within the text of the paper, so we will remove the 
author’s name from the citation. We also want to add a page 
reference to this particular citation.

To edit an individual citation:

1. Click anywhere on the Morehouse citation.

2. Word 2003: From the Tools menu, go to the EndNote X2 
submenu and then Edit Citations. 

Word 2007: On the EndNote tab, in the Citations group, 
select Edit Citations.

3. In the Formatted Citation section, select the Exclude Author 
box.
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4. Next to Pages, type “34-35”.

NOTE: Typing cited page numbers in this box does not guarantee that 
they will appear in your citation. You must use an output style that lists 
the “Cited Pages” field in the Citation template. You can edit any style 
to include this special field.

5. Click OK to update the citation in your paper.

Insert Figure 
Citations

Next you are going to insert two figure citations—one inserted 
and numbered as a figure, and one inserted and numbered as a 
table. This section uses the reference inserted in Chapter 4: 
“Entering a Reference,” as well as another reference in the 
sample library.

All figure citations are inserted in the same way; the EndNote 
reference type determines whether it is inserted and numbered 
as a figure or a table. Images found in the Chart or Table reference 
type are inserted as tables, while images found in any other 
reference type are inserted as figures.

To find and insert figure citations:

1. First, add more text to your paper:

As researchers look at evidence, even the 
crest on the modern cockatiel provides insight 
into the evolution of feathers.

Now you are ready to insert a figure citation. 

2. Word 2003: From the Tools menu, go to the EndNote X2 
submenu and then Find Figure(s). 

The fossil in question was generally regarded to be the 220 

million year-old remains of tyrannosaurus. Several years ago, however, 

Morehouse overturned this hypothesis with the discovery of yet another 

species. (1993, pp. 34-35) It is now the undisputed progeny of the 

species at hand. (Turnhouse, 1987)

Morehouse, S.I. & Tung, R. S. (1993). Statistical evidence for early 
extinction of reptiles due to the K/T event. Journal of 
Paleontology, 17(2), 198-209.

Turnhouse, M. B. (1987). Role of 14C dating in paleontology. Journal 
of Paleontology, 75(6), 11-15.
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Word 2007: On the EndNote tab, in the Citations group, click 
on the Insert Citation text and select Find Figure.

The EndNote Find Figures dialog appears. 

3. Type the search term “bird” in the “Find” box and click 
Search.

EndNote lists only references that match the search text and 
contain an image. As you highlight a reference, the graphic 
stored within the reference is displayed below the reference 
list. (Object files display a file icon.)

You can use your mouse to move the column dividers to set 
column widths and to drag the lower right corner of the 
window to adjust the size of the window.

4. Select the reference with the Caption “Cockatiel Crest 
Feathering,” a reference inserted earlier in this guided tour, 
and click Insert to insert the figure citation.

5. Next enter the text:

While exploring the evolution of dinosaurs 
and birds, it is interesting to also explore 
a parallel time line of extinctions.

As researchers look at evidence, even the crest on the modern 

cockatiel provides insight into the evolution of feathers. (Figure 1)
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Now you are ready to insert a reference to a Microsoft Excel 
file that was saved in the Figure field of an EndNote 
reference that uses the Chart or Table reference type.

6. Word 2003: From the Tools menu, go to the EndNote X2 
submenu and then Find Figure(s). 

Word 2007: On the EndNote tab, in the Citations group, click 
on the Insert Citation text and select Find Figure.

The EndNote Find Figures dialog appears. 

7. Type the text “extinction” in the “Find” box and click Search.

EndNote displays a single matching reference. The file 
attachment icon shows that the figure is in a Microsoft Excel 
document.

8. Click Insert to insert the citation. (It may take some time for 
Word to import the file.)

The image was found in the Chart or Table reference type, so 
it was added to Word and numbered as a table.

9. Scroll to the end of the document, and you will find that 
EndNote used Word bookmarks to place the images under 
labeled List of Tables and List of Figures sections as defined 
by the APA style. 

As researchers look at evidence, even the crest on the modern 

cockatiel provides insight into the evolution of feathers. (Figure 1)

While exploring the evolution of dinosaurs and birds, it is 

interesting to also explore a parallel time line of extinctions. (Table 1)
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10. You may want to resize your figures to fit on the page 
appropriately. Click on an image, and then hold down the 
Shift key while you drag a corner of the figure to resize it 
proportionally. 

11. You can also reduce the size of the Cockatiel Crest 
Feathering graphic.

As you are working, remember to often Save your document. 
You can continue adding text, bibliographic citations, and figure 
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citations to the paper, and EndNote will continue adding to the 
lists of references, figures, and tables!

This completes the guided tour. You can close Microsoft Word:

Word 2003: Exit Word by choosing Exit from the File menu. 
Word 2007: Click the Office icon and then Exit Word.

To close the EndNote program, go to the File menu in EndNote 
and choose Exit.

Related 
Sections in the 
Full Manual

See these sections in the full EndNote.PDF manual for 
information related to this portion of the tour:

The process of citing references and figures and creating 
bibliographies with Cite While You Write is covered in 
Chapter 11.

More than 3,000 styles are installed in EndNote’s Styles 
folder. To see a list of them organized by discipline, choose 
Output Styles from the Edit menu and select the Style 
Manager. See “Accessing Styles in Other Places” in Chapter 
16 for information about how to access other styles.

Chapter 16, “Bibliographic Styles,” includes instructions for 
editing output styles.
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